
        
            
                
            
        

    
Objective
 
  The Cisco FindIT Network Management provides tools that help you easily monitor, manage, and configure your Cisco 100 to 500 Series network devices such as switches, routers, and wireless access points (WAPs) using your web browser. It also notifies you about device and Cisco Support notifications such as the availability of new firmware, device status, network settings updates, and any connected devices that are no longer under warranty or covered by a support contract. 
 
  The FindIT Network Management is a distributed application which is comprised of two separate components or interfaces: one or more Probes referred to as FindIT Network Probe and a single Manager called FindIT Network Manager.
 
  An instance of FindIT Network Probe installed at each site in the network performs network discovery and communicates directly with each Cisco device. In a single site network, you may choose to run a standalone instance of FindIT Network Probe. However, if your network comprises multiple sites, you may install FindIT Network Manager at a convenient location and associate each Probe with the Manager. From the Manager interface, you can get a high-level view of the status of all the sites in your network, and connect to the Probe installed at a particular site when you wish to view detailed information for that site.
 
  This article provides instructions on how to install and configure FindIT Network Manager and FindIT Network Probe using a VMware virtual machine (VM).
 
  Note: If you prefer to install and configure FindIT Network Manager and Probe on a different platform, click here for Oracle VM VirtualBox Manager, or click here for Microsoft Hyper-V Manager.
 
  
Install FindIT Network Manager on VMware
 
  For the FindIT Network Manager, an Open Virtual Appliance (OVA) format VM image can be deployed to VMware products.
 
  Install FindIT Network Manager using any of the available virtual machines below and then configure its deployment:
 
  VMware Fusion
 
  VMware vSphere Client
 
  VMware Workstation Pro
 
  Configure the Deployed FindIT Network Manager
 
  Install FindIT Network Probe using any of the available virtual machines:
 
  VMware Fusion
 
  VMware vSphere Client
 
  VMware Workstation Pro
 
  Configure the Deployed FindIT Network Probe
 
  Install FindIT Network Manager using VMware Fusion
 
  Follow these steps to deploy the OVA VM image to VMware Fusion.
 
  Step 1. Download the FindIT Network Manager OVA VM image from the Cisco Small Business Site.
 
  Step 2. Launch the VMware Fusion application on your server or computer.
 
  
 
  Note: In this example, Mac OS X El Capitan is used.
 
  Step 3. Click Import an existing virtual machine, then click Continue.
 
  
 
  Note: Alternatively, you can click the Add button then click Import.
 
  
 
  Step 4. Click Choose File.
 
  
 
  Step 5. Click the downloaded OVA image in Step 1, then click Open.
 
  
 
  Step 6. Click Continue.
 
  
 
  Step 7. (Optional) Enter a name for the FindIT Network Manager.
 
  
 
  Note: In this example, FindIT Network Manager.wmwarevm is used.
 
  Step 8. Click Save.
 
  Step 9. Review the Virtual Machine Summary then click Finish.
 
  
 
  Step 10. Once the deployed VM appears, click the Play button.
 
  
 
  Note: Once the VMware has completed the deployment, the FindIT Network Manager will be displayed in the Virtual Machine Library under VIRTUAL MACHINES.
 
  
 
  Step 11. Proceed to the Configure the Deployed FindIT Network Manager section to configure the deployed appliance.
 
  [Back to Top]
 
  Install FindIT Network Manager using VMware vSphere Client
 
  Follow these steps to deploy the OVA VM image to VMware vSphere Client.
 
  Important: Before proceeding with the installation steps, make sure you have the following:
 
   
   	vCenter or ESXi server credentials:
 
  
 
  – Name or IP address
 
  – User name
 
  – Password
 
   
   	Pre-configured datastore in the server
 
   	Pre-configured VM Network
 
  
 
  Step 1. Download the FindIT Network Manager OVA VM image from the Cisco Small Business Site.
 
  Step 2. Launch the VMware vSphere Client on your server or computer.
 
  
 
  Note: In this example, Windows 2012 Server R2 operating system is used.
 
  Step 3. Enter the vCenter or ESXi server name or IP address in the IP address / Name field.
 
  
 
  Note: In this example, the ESXi server IP address of 10.2.0.10 is used.
 
  Step 4. Enter the user name and password of the server in the User name and Password fields.
 
  
 
  Step 5. Click Login.
 
  Step 6. (Optional) If a datastore has not been created in the server, add a new storage in the Configuration tab.
 
  
 
  Step 7. Click File > Deploy OVF Template.
 
  
 
  Step 8. Click Browse.
 
  
 
  Step 9. Click the downloaded OVA image in Step 1, then click Open.
 
  
 
  Step 10. Click Next to continue.
 
  
 
  Step 11. Click Next.
 
  
 
  Step 12. Enter a name for the FindIT Network Manager in the Name field, then click Next.
 
  
 
  Note: In this example, FindIT Network Manager is used.
 
  Step 13. Choose a destination storage for the FindIT Network Manager VM, then click Next.
 
  
 
  Note: In this example, Virtual Machine DataStore is chosen.
 
  Step 14. Click a storage provision then click Next.
 
  
 
  The options are:
 
   
   	Thick Provision Lazy Zeroed — This option creates a virtual disk in a default thick format.
 
   	Thick Provision Eager Zeroed — This creates a type of thick virtual disk that supports clustering features.
 
   	Thin Provision — You can use this format to save storage space.
 
  
 
  Note: In this example, Thick Provision Lazy Zeroed is chosen.
 
  Step 15. Choose a network then click Next.
 
  
 
  Note: In this example, VM Network is used.
 
  Step 16. Review the configured settings.
 
  
 
  Step 17. (Optional) Check the Power on after deployment check box to launch the VM after deployment.
 
  
 
  Step 18. Click Finish to complete the installation.
 
  Step 19. Once deployment has been completed, click Close.
 
  
 
  Step 20. Click the deployed VM then click Power on the virtual machine.
 
  
 
  Note: Alternatively, you can click the Play button to power on the VM.
 
  
 
  Step 21. (Optional) To access the console, right-click on the FindIT Network Manager VM then choose Open Console.
 
  
 
  Step 22. Proceed to the Configure the Deployed FindIT Network Manager section to configure the deployed appliance.
 
  [Back to Top]
 
  Install FindIT Network Manager using VMware Workstation Pro
 
  Follow these steps to deploy the OVA VM image to VMware Workstation Pro.
 
  Step 1. Download the FindIT Network Manager OVA VM image from the Cisco Small Business Site.
 
  Step 2. Launch the VMware Workstation Pro application on your server or computer.
 
  
 
  Note: In this example, Windows 8 operating system is used.
 
  Step 3. Click Open a Virtual Machine from the Home tab.
 
  
 
  Step 4. Click the downloaded OVA image in Step 1, then click Open.
 
  
 
  Step 5. (Optional) Enter a name for the FindIT Network Manager.
 
  
 
  Note: In this example, FindIT Network Manager is used.
 
  Step 6. Click Import.
 
  Note: Once the VMware has completed the deployment, the FindIT Network Manager will be displayed in the Library under My Computer.
 
  Step 7. On the left panel, click the deployed FindIT Network Manager appliance.
 
  
 
  Step 8. Click Power on this virtual machineo access the console of the VM.
 
  
 
  Step 9. Proceed to the Configure the Deployed FindIT Network Manager section to configure the deployed appliance.
 
  [Back to Top]
 
  Configure the Deployed FindIT Network Manager
 
  Once deployment of the FindIT Network Manager is completed using your preferred virtual machine, follow the steps below to configure the VM.
 
  Step 1. Access the console of the FindIT Network Manager VM.
 
  Step 2. Log in to the console using the default username and password: cisco/cisco.
 
  [image: ]
 
  Step 3. Once you are prompted to change the password for the cisco account, enter the current password.
 
  
 
  Step 4. Enter and retype the new password for the cisco account.
 
  
 
  The DHCP IP Address and Administration GUI address will be displayed.
 
  
 
  Note: In this example, the IP Address of FindIT Network Manager is 192.168.1.101 and the Administration GUI address is https://192.168.1.101.
 
  Step 5. Enter the sudo config_vm command to start the initial setup wizard.
 
  [image: ]
 
  Step 6. Enter the password for sudo. The default password is cisco. If you changed it, enter the new password.
 
  
 
  Step 7. Enter y for Yes or n for No in the setup wizard to configure the Hostname, Network, NTP server, and Time Zone.
 
  
 
  Step 8. (Optional) If DHCP is specified when configuring network, enter the ifconfig command to check the assigned IP address and remember it. A static IP can also be configured.
 
  [image: ]
 
  You should now have completed the FindIT Network Manager installation on your VM.
 
  To learn how to access and configure the initial settings of the FindIT Network Manager, click here for instructions.
 
  [Back to Top]
 
  
Install FindIT Network Probe
 
  Install FindIT Network Probe using VMware Fusion
 
  Follow these steps to deploy the OVA VM image to VMware Fusion.
 
  Step 1. Download the FindIT Network Probe OVA VM image from the Cisco Small Business Site.
 
  Step 2. Launch the VMware Fusion application on your server or computer.
 
  
 
  Note: In this example, Mac OS X El Capitan is used.
 
  Step 3. Click the Add button then click Import.
 
  
 
  Step 4. Click Choose File.
 
  
 
  Step 5. Click the downloaded OVA image in Step 1, then click Open.
 
  
 
  Step 6. Click Continue.
 
  
 
  Step 7. (Optional) Enter a name for the FindIT Network Probe.
 
  
 
  Note: In this example, FindIT Network Probe.wmwarevm is used.
 
  Step 8. Click Save.
 
  Step 9. Review the Virtual Machine Summary then click Finish. The deployed VM will automatically start.
 
  
 
  Note: Once the VMware has completed the deployment, the FindIT Network Probe will be displayed in the Virtual Machine Library under VIRTUAL MACHINES.
 
  
 
  Step 9. Proceed to the Configure the Deployed FindIT Network Probe section to configure the deployed appliance.
 
  [Back to Top]
 
  Install FindIT Network Probe using VMware vSphere Client
 
  Follow these steps to deploy the OVA VM image to VMware vSphere Client.
 
  Important: Before proceeding with the installation steps, make sure you have the following:
 
   
   	vCenter or ESXi server credentials:
 
  
 
  – Name or IP address
 
  – User name
 
  – Password
 
   
   	Pre-configured datastore in the server
 
   	Pre-configured VM Network
 
  
 
  Step 1. Download the FindIT Network Probe OVA VM image from the Cisco Small Business Site.
 
  Step 2. Launch the VMware vSphere Client on your server or computer.
 
  
 
  Note: In this example, Windows 2012 Server R2 operating system is used.
 
  Step 3. Enter the vCenter or ESXi server name or IP address in the IP address / Name field.
 
  
 
  Note: In this example, the ESXi server IP address 10.2.0.10 is used.
 
  Step 4. Enter the user name and password of the server in the User name and Password fields.
 
  
 
  Step 5. Click Login.
 
  Step 6. (Optional) If a datastore has not been created in the server, add a new storage in the Configuration tab.
 
  
 
  Step 7. Click File > Deploy OVF Template.
 
  
 
  Step 8. Click Browse.
 
  
 
  Step 9. Click the downloaded OVA image in Step 1, then click Open.
 
  
 
  Step 10. Click Next to continue.
 
  
 
  Step 11. Click Next again.
 
  
 
  Step 12. Enter a name for the FindIT Network Probe in the Name field, then click Next.
 
  
 
  Note: In this example, FindIT Network Probe is used.
 
  Step 13. Choose a destination storage for the FindIT Network Probe VM, then click Next.
 
  
 
  Note: In this example, Virtual Machine DataStore is chosen.
 
  Step 14. Click a storage provision then click Next.
 
  
 
  The options are:
 
   
   	Thick Provision Lazy Zeroed — This option creates a virtual disk in a default thick format.
 
   	Thick Provision Eager Zeroed — This creates a type of thick virtual disk that supports clustering features.
 
   	Thin Provision — You can use this format to save storage space.
 
  
 
  Note: In this example, Thick Provision Lazy Zeroed is chosen.
 
  Step 15. Choose a network then click Next.
 
  
 
  Note: In this example, VM Network is chosen.
 
  Step 16. Review the configured settings.
 
  
 
  Step 17. (Optional) Check the Power on after deployment check box to launch the VM after deployment.
 
  
 
  Step 18. Click Finish to complete the deployment.
 
  Step 19. Once deployment has been completed, click Close.
 
  
 
  Step 20. Click the deployed VM then click Power on the virtual machine.
 
  
 
  Note: Alternatively, you can click the Play button to power on the VM.
 
  
 
  Step 21. (Optional) To access the console, right-click on the FindIT Network Probe VM, then choose Open Console.
 
  
 
  Step 22. Proceed to the Configure the Deployed FindIT Network Probe section to configure the deployed appliance.
 
  [Back to Top]
 
  Install FindIT Network Probe using VMware Workstation Pro
 
  Follow these steps to deploy the OVA VM image to VMware Workstation Pro.
 
  Step 1. Download the FindIT Network Probe OVA VM image from the Cisco Small Business Site.
 
  Step 2. Launch the VMware Workstation Pro application on your server or computer.
 
  
 
  Note: In this example, Windows 8 operating system is used.
 
  Step 3. Click Open a Virtual Machine from the Home tab.
 
  
 
  Step 4. Click the downloaded OVA image in Step 1, then click Open.
 
  
 
  Step 5. (Optional) Enter a name for the FindIT Network Probe.
 
  
 
  Note: In this example, FindIT Network Probe is used.
 
  Step 6. Click Import.
 
  Note: Once the VMware has completed the deployment, the FindIT Network Probe will be displayed in the Library under My Computer.
 
  Step 7. On the left panel, click to choose the deployed FindIT Network Probe appliance.
 
  
 
  Step 8. Click Power on this virtual machine to access the console of the VM.
 
  
 
  Step 9. Proceed to the Configure the Deployed FindIT Network Probe section to configure the deployed appliance.
 
  [Back to Top]
 
  Configure the Deployed FindIT Network Probe
 
  Once deployment is finished, follow the steps below to configure the VM.
 
  Step 1. Access the console of the FindIT Network Probe VM.
 
  Step 2. Log in to the console using the default username and password: cisco/cisco.
 
  
 
  You will be prompted to change the password for the cisco account. The DHCP IP Address and Administration GUI address will be displayed.
 
  
 
  Note: In this example, the IP Address of FindIT Network Probe is 192.168.1.102 and the Administration GUI address is https://192.168.1.102.
 
  Step 3. Enter and retype the new password for the cisco account.
 
  
 
  Step 4. (Optional) Enter the ifconfig command to find the IP address of FindIT Network Probe.
 
  
 
  You should now have configured FindIT Network Probe on your machine.
 
  [Back to Top]
 
  To learn how to access and configure the initial settings of the FindIT Network Probe, click here for instructions. To learn how to associate the FindIT Network Probe to the FindIT Network Manager, click here for instructions.
  
 ijgm_120216_install-findit-fusion-manager_step7.png
Where: [ Virtual Machines. B

~ Share this virtual machine with other users on this Mac

‘Some features will b limited when sharing a virtual machine.
‘Sharing is only available when the virtual machine is saved in a shared

Cancel






ijgm_120216_install-findit-fusion-manager_step9.png
Finish

The configuration of the virtual machine is now c

Virtual Machine Summary
Guest Operating System Cent0S 64-
Memory 2 6B
Networking Autodetect (Bridged)
Device Summary CD/DVD, Floppy

To change the default virtual machine settings, click Customize Settings. To.
run the virtual machine now, click Finish.

Customize Settings






ijgm_120216_install-findit-fusion-manager_step5.png
Name ~  Date Modified

Oct 4, 2016, 5:13 AM|

Cancel






ijgm_120216_install-findit-fusion-manager_step6.png
Choose an Existing Virtual Machine

ancel





ijgm_120216_install-findit-fusion-manager_step3a.png





ijgm_120216_install-findit-fusion-manager_step2.png
ceyme





ijgm_120216_install-findit-fusion-manager_step4.png
Recent items:

ing Virtual Machine

Cancel

Go Back





ijgm_120216_install-findit-fusion-manager_step3.png
Select the Installation Method

S0 importan existing PC

=, Install OS X from the recovery
= partition

Import an existing virtual machine

v,

Install from Boot Camp

—) Create a custom virtual machine

Install from disc or image






ijgm_120216_install-findit-fusion-probe_step9a.png
ece Virtual Machine Library
+v = B > A &
Add View Resume Settings Snapshots
VIRTUAL MACHINES N
N FindIT Network Probe
' FindIT Network Manager AT e

B FindiT Network






ijgm_120216_install-findit-vsphere-probe_step3.png
VMware vSphere Client
vmware'

VMware vSphere™
Client

(5] Al viphere featres nvoduced invSphere 5.5 and beyond are
avaiaie orly brough the vSphere ieb Clent. The Gadtonl
Vephere Clent i contre t cperate, supportng te same
featre set s viphere 5.0

To drectly manage a snge host, enter the 1P address o host name.
To manage multle hosts, enter the IP address o name of &
VCenter Server.

1 address [Nome: [[10:20.00

User name: |
Password: |





ijgm_120216_install-findit-vsphere-probe_step2.png





ijgm_120216_install-findit-fusion-manager_step10.png





ijgm_120216_install-findit-vsphere-manager_step2.png





ijgm_120216_install-findit-vsphere-probe_step6.png
localhost.localdomain VMware 0759 | Evaluation (60 days

Getting Started | Summary | Virtual Machines 'Resource Allocation | Performancs

‘The ESXi host does not have persistent storage.
To run virtual machines, reate at east one datestore for maintaining virtual machines and other system fies.

Note: IF you plan to use ISCSI or a network fie system (NFS), ensure that your storage adapters and network cos
before contining.

To add storage nowf{click hereto creste 2 datastore,





ijgm_120216_install-findit-fusion-manager_step10a.png
ece Virtual Machine Library

[SNEY -

Add View StartUp Settings Snapshots

VIRTUAL MACHINES Name

' FindIT Network Manager  FindT Network Manager





ijgm_120216_install-findit-vsphere-probe_step4.png
To drectly manage a single host, enter the IP address or host name..
‘Tomanage mulie hosts, enter the IP address o name of 2
VCenter Server.

Poddress/Neme: [02000 ]
User name: =
Passord: =

™ Use Windows sesson redentils

[Croon | cose





cover.jpg
Nme
CISCO.

=
Install and Configure FindIT
Network Manager and FindIT
Network Probe on a VMware Virtual
Machine






ijgm_120216_install-findit-fusion-probe_step4.png
Choose an Existing Virtual Machine

ancel





ijgm_120216_install-findit-fusion-probe_step3.png





ijgm_120216_install-findit-fusion-probe_step6.png
ecent items:

Cent0SE8-FindiTManager-1.0.0.20160928
& stz vnromn
rypes Oer Showin Finder

OpenWRT-FindiTProbe-1.0.1.163

Type: Other

Choose File...

ancel Go Back Continue





ijgm_120216_install-findit-fusion-probe_step5.png
Name ~  Date Modified

Oct 4, 201
Oct 4, 2016, 2

Cancel






ijgm_120216_install-findit-fusion-probe_step9.png
Virtual Machine Summary
Guest Operating System Other Linux 64-bit
Memory 512 MB
Networking Autodetect (Bridged)
Device Summary None

To change the default virtual machine settings, click Customize Settings. To
run the virtual machine now, click Finish.

Customize Settings






ijgm_120216_install-findit-fusion-probe_step7.png
save As: [FindIT Network Probeymwarevm

Tags:
Where: 19 Virtual Machines

~ Share this virtual machine with other users on this Mac.

rtual machine.
is saved

a shared

cancel (3






ijgm_120216_install-findit-vsphere-probe_step13.png
‘Select a destnation storage for the virtual machine fies:
=3

TomeTope | Canacty | Proviionsd | oo | Type
NonSD  45625GB 57400Mp  45530G8 MFSS

>
T Disabe Storage ORS forthis vitual machine

Selecta datastore:

Name. DriveType | Capacky | Provisoned | ___Free [ Type | ThinProv






ijgm_120216_install-findit-vsphere-probe_step12.png
“The name can contain up to 80 characters and it mustbe unique within the inventory foder.






ijgm_120216_install-findit-vsphere-probe_step15.png
Map the networks used in this OVF template to networks in your inventory

TDestiaton Networks
VM Network

W B






ijgm_120216_install-findit-vsphere-probe_step14.png





ijgm_120216_install-findit-vsphere-manager_step14.png





ijgm_120216_install-findit-vsphere-probe_step17.png





ijgm_120216_install-findit-vsphere-manager_step13.png
Select a destination storage for the virtual machine fles:
=3

TorveTyps | Capacky | Provisned | Free | Type

Non-SD 456258 97400MB 455308 VMFSS

>
F o Storage DRS for this virtual machine

seecta dtastore:

e Drve Type | Capocty [ Provsensd | Free [Tvoe [ Thmror
<






ijgm_120216_install-findit-vsphere-probe_step16.png
When you cick Finish, the deployment task vl be started.

C:\Users\administrator\Dovwloads\OpenWRTAnd ..
9s4MB

1068

FindITNetwork Probe

localhost.outer-minecom

Virtual Machine DataStore:

ThickProvision Lazy Zeroed

VM Network"to VM Network"

T Poner on after deployment.






ijgm_120216_install-findit-vsphere-manager_step4.png
Yo drrectly manage a single host, enter the IP address or host name.
‘To manage muie hosts, enter the [P address orname of

VCenter Server.
P address [Name:  [10.2.0.10 <]
User name:

Password:

[Crom | cose |





ijgm_120216_install-findit-vsphere-probe_step8.png
Deploy froma fle or URL

Enter a URL to download and nstal the OVF package from the Internet, or
‘specify alocation accessbie from your computer, such as a local hard drive, &
network share, or a CO/DVD dive.





ijgm_120216_install-findit-vsphere-manager_step3.png
VMware vSphere Client

vmware'

VMware vSphere™
Client

(5] Al viphere featres nvoduced invSphere 5.5 and beyond are
avaiaie orly brough the vSphere ieb Clent. The Gadtonl
Vephere Clent i contre t cperate, supportng te same
featre set s viphere 5.0

To drectly manage a snge host, enter the 1P address o host name.
To manage multle hosts, enter the IP address o name of &
VCenter Server.

1P address [ Nome:

User name:
Password:

™ Use Windows sesson redentils

e





ijgm_120216_install-findit-vsphere-probe_step7.png





ijgm_120216_install-findit-vsphere-manager_step7.png





ijgm_120216_install-findit-vsphere-probe_step10.png
Deploy from a fle or URL
[ ers it atorPowrionds Open T FrdTPrabe 1] [ sromse.
Enter 2 URL todonrioad and nstal the OVF package ram th Intermet o

‘specty alocaton accessile from your computer, ach 2 8 local hard dive, &
network shae, or 3 CODVD dive.






ijgm_120216_install-findit-vsphere-manager_step6.png
localhost localdomain VMware ESXi, 0759 | Evaluation (60 days

Getting Started | Summary | Virtual Machines 'Resource Allocation | Performancs

‘The ESXi host does not have persistent storage.
To run virtual machines, reate at east one datestore for maintaining virtual machines and other system fies.

Note: IF you plan to use ISCSI or a network fie system (WFS), ensure that your storage adapters and network conn
before contining.

To add storage nowf{click hereto creste 2 datastore,






ijgm_120216_install-findit-vsphere-probe_step9.png
Name Date modified Type

< e

>
sme: [OpenWRT-FindTProbe-1.0.11673 v| [OVF packages Covirove)  v]






ijgm_120216_install-findit-vsphere-manager_step9.png
Neme Date modified Type

(oo ooz ) 07t 252, OiAFie

101772016 1156...  OVAFile

e — 5

me:[Cent0S62-FindTManager-1.002¢ v| [OVF packsges (ovimova) v






ijgm_120216_install-findit-vsphere-manager_step8.png
Deply froma fle or URL

Enter a URL to download and nstal the OVF package from the Internet, or
‘specify alocation accessbie from your computer, such as a local hard drive, &
network share, or a CO/DVD dive.





ijgm_120216_install-findit-vsphere-probe_step11.png
Szeondsk:

9548

1258.6 M8 (thin provisoned)
1068 (#ick provisoned)






ijgm_120216_install-findit-vsphere-manager_step11.png
Cent0S67_OM _Template:

1268

2.1G8 (thn provisoned)
16.0G8 (tick proviioned)






ijgm_120216_install-findit-vsphere-manager_step10.png
Deploy from a e or URL

e e s [ e

Enter 2 RL to dowrioad and ntal the OVF padiage fom the Internet, or
speafy a ocaton accessbe from your conputer, such as 2 local hard drive, &
network share, or & COPDVD deve.






ijgm_120216_install-findit-vsphere-manager_step12.png
“The name can contain up to 80 characters and it st be unique within the inventry foldr.






ijgm_120216_install-findit-pro-probe_step2.png
Google

Chrome

Mozilla
Firefox

FindIT20






ijgm_120216_install-findit-pro-probe_step4.png
Local Disk (D) » FindIT - Search FindIT 2

o e

New folder

Name Date modified Type

@ CentOSES-FindTManager-L00 20160928, 10/4/2016513 AM__ Open Vitualzsto

(%) OpenWRT-FindITProbe-1 0116301 10/4/2016236 AM__ Open Virtuaizatio.

Eul i ] '

File name: OpenWRT-FindITProbe-10.11630 v | All supported files






ijgm_120216_install-findit-pro-probe_step3.png
WORKSTATION™ 12 1

+ ) ®

Create a New Open a Virtual Connect toa
Virtual Machine Machine Remote Server





ijgm_120216_install-findit-pro-manager_step3.png
() VMware Workstation

Fle Edt View VM Tabs Hep | - | |

o= =

Library S 1
Q Typeheretosearch v
I My Computer . ) ;
{Shared Uiz W Your evaluation period ends in 25 days.

WORKSTAT

Create a New Open a Virtual
Virtual Machine Machine






ijgm_120216_install-findit-pro-probe_step7.png
Fle Edt View VM Tabs Help | P v |

O |

2 | £

Library

Q Type hereto search

{5 Fnd Wetwork Probe > | (51 Fnd e
@ FindIT Network Probe

> Power on this virtual machine
Eieditvirtusl machine settings
(5 Upgrade thisvirtual machine

~ Devices
8 Memory 512MB
[ Processors. 1

(2 Hard Disk IDE)  1GB
T Network Adapter Bridged (Autorn...
Display

1 monitor





ijgm_120216_install-findit-pro-probe_step5.png
Store the new Virtual Machine.

Provide a name and local storage path fo the new.
vitual machine.

Name for the new virtual machine:

Storage path for the new virtual machine:
C:\sers\Cisco\Documents Vitual Machnes\Find [ Bronse...

Cre ] [Comeot J [ conel ]






ijgm_120216_install-findit-pro-manager_step5.png
Store the new Virtual Machine.

Provide a name and local storage path fo the new.
vitual machine.

machine:

Storage path for the new virtual machine:
C:\Wsers\Cisco\Pocuments\Vrtual Machines Find [ Browse...

T o ) (oo )






ijgm_120216_install-findit-probe_step2.png
FindITProbe login: cisco
Password: cisco






ijgm_120216_install-findit-pro-manager_step4.png
Local Disk (D) » FindIT %3 [ Search Fina »

- 0 @

Date modified Type

10/4/2016513AM _ Open Virtuaizatio,
10/4/2016236 AM  Open Virtualizatio.

< i ) }

File name:  CentOSE8-FindITManager-10.0.20 v [ All supported files






ijgm_120216_install-findit-pro-probe_step8.png
{51 FindIT Network Probe x}

@ FindIT Network Probe

5 Upgrade thisvirtual machine

~ Devices
8 Memory 512MB
[ Processors. 1

(ZHard Disk (D) 168
T Network Adapter  Bridged (Autom...
[WDisplay 1 monitor





ijgm_120216_install-findit-vsphere-manager_step16.png
‘When you cick Finish, the deployment task wil be started.

Deployment setings:

OVFfile: Ci\Users\administratoriDesktop\FindIT Beta 6| Cat0Si—.
Downloadsie: 1268

Szeondisk: 15068

Name: FindITNetwork Manager

Host/Cluster: localhost.router-minecom

Datastore: Virtual Machine DataStore

Diskprovisnng: Thck Provision Lazy Zeroed

Network Mapping: VM Network”to VM Network”

T Power on after deployment






ijgm_120216_install-findit-vsphere-probe_step20.png
File Edit View Inventory Administration Plug-ins Help
(< N>] ‘gm b & Tventory b @) Inventory.

What is a Virtual Machine?

Avirtual machine is a software computer
physical computer, runs an operating sys
‘applications. An operating system install
machine s called a guest operating syste
Because every virtual machine is an isolz
‘environment, you can use virtual machin
workstation environments, s testing env
consolidate server appiications.

Virtual machines run on hosts. The same
many virtual machines.

Basic Tasks.

Power on the virtual machine

& Edit virtual machine settings






ijgm_120216_install-findit-vsphere-manager_step15.png
'Map the networks used n this OVF template to networks in your inventory.

TDestiaton Networks
VM Network

W B






ijgm_120216_install-findit-vsphere-probe_step19.png
) Deployment Completed Successfully | = | & [FXT]

Deploying FndIT Network Probe
Conpleted Successfly






ijgm_120216_install-findit-vsphere-manager_step19.png
& Deployment Completed Successfully [ = | © [EXI

Deploying FndIT Network Manager
Conpleted Successflly






ijgm_120216_install-findit-vsphere-probe_step21.png
Edit Setings...
Add Permission... ctlep.
Report Performance...

Rename |
Openin New Window... Ctl+AsN |

Remove from Inventory
De






ijgm_120216_install-findit-vsphere-manager_step17.png





ijgm_120216_install-findit-vsphere-probe_step20a.png
File Edit View Inventory Adn

& Virtual Deskiop.





ijgm_120216_install-findit-vsphere-manager_step20a.png
aa

@

File Edit View Inventory Admir
@ Home b

n I:IG\B @

10.20.00

@ FodiT Network Probe
@ Virtal Desktop.





ijgm_120216_install-findit-vsphere-manager_step20.png
File Edit View Inventory Administration Plug-ins Help

G B [0 rome > ey b Iventory
mu»ooaboe s

&) VirtualDeskiop

What is a Virtual Machine?

Avirtual machine s a software comput
physical computer. runs an operating ¢

‘appiications. An operating system inst:
machine is called a guest operating sy

Because every virtual machine is an is
‘environment, you can use virtual mach
workstation environments, as testing &
consolidate server applications.

Virtual machines run on hosts. The sal
many virtual machines.

Basic Tasks.

 Edit virtual machine settings





ijgm_120216_install-findit-pro-manager_step2.png
Google

Chrome

Mozilla
Firefox

FindIT20






ijgm_120216_install-findit-vsphere-manager_step21.png
DGBK&WEH‘\)@}

@ ot setings..
‘AddPermission.. aup
ReportPerormance..

Rename

Openin New Window... Ctrl+AltsN
Remove from Inventory
Delete from Disk





ijgm_120216_install-findit-manager_step7.png
Config a hostname 7 (y/m) :

y






ijgm_120216_install-findit-manager_step6.png
[ciscoBFindITHanager ~1$ cd sopt/cisco
[ciscoBFindITHanager ciscol$ sudo config_um
[sudo] password for cisco:






ijgm_120216_install-findit-fusion-probe_step2.png
ceRmE





ijgm_120216_install-findit-manager_step8.png
[ Teisco@PindITManager ciscol$ ifconfig






ijgm_120216_install-findit-pro-manager_step8.png
Fie Edt View WM Tabs Help | P+

Library.

x

Q Type hereto search

= [ My Computer
(5 FindIT Network Manager
5 Shared VMs

{51 FindIT Network Manager x}

5 Upgrade thisvirtual machine

~ Devices
8 Memory

[ Processors.

268
1

2 Hard Disk (SCSI)  16.GB.

)CD/DVD (1DE)
 Flopy

Auto detect
Using drive A:

T Network Adapter Bridged (Autorn...

Display

1 monitor





ijgm_120216_install-findit-probe_step3.png
hanging password for cisco
ew password:

etype password:

assword for cisco changed by cisco
isco@Find ITProbe:™# _






ijgm_120216_install-findit-pro-manager_step7.png
File Edit View VM Tabs Help

Library.

Q Type hereto search -

= My
L=






ijgm_120216_install-findit-probe_step2a.png
usyBox v1.23.2 (2016-89-82 17:15:18 CST) built-in shell (ash)

FindIT Probe (1.8.1.16381)
Powered by Openkrt CHAOS CALMER (15.85, r47955)

IP Address: 192.168.1.182  Administration GUI: https://192
Enter 'config_um’ to change platform settings and set a stati

hanging password for cisco
ew password: _





ijgm_120216_install-findit-manager_step3.png
ent0S release 6.8 (Final)
ernel 2.6.32-642.3.1.e16.x86_64 on an xB6_64

indITManager login: cisco
assword :

fou are required to change your password immediately (root enforced)
hanging password for cisco.

(current) UNIX password:





ijgm_120216_install-findit-manager_step2.png
FindITManager login: cisco
Password: cisco






ijgm_120216_install-findit-probe_step4.png
“# ifconfig

ddr 88:8C:29:6F:2E:DD
Beast:192.168.1.255 Mask:
£1:fe6f:2edd/64 Scope:Link
inet6 addr 951 : fe6f:2edd/64 Scope:Site
UP BROADCAST RUNNING MULTICAST MTU:1588 Metric:1
RX packets:149596 errors:8 dropped overruns:8 fra
TX packets:285286 errors:8 dropped:8 overruns:@ car
collisions:B txqueuelen:1868
RX bytesi26494354 (25.2 MiB) TX bytes:183876388 (1

Link encap:Local Loopback
inet addr:127.8.8.1
inet6 addr
UP LOOPBACK RUNNING MTU:65536 Metric:i
RX packets:73994 errors:8 dropped:B overruns:@ frar
TX packets:73994 errors:@ dropped:8 overruns:® carr
collisions:8 txqueuelen:d

RX bytes:33273411 (31.7 MiB) TX bytes:

3273411 (31





ijgm_120216_install-findit-manager_step4a.png
ent0S release 6.8 (Final)
ernel 2.6.32-642.3.1.e16.x86_64 on an x86_64

FindITHanager login: cisco
Password :

fou_are required to change your password immediately (root enforced)
hanging password for cisco.

ety U st

few password :

Retype new password:

FindIT Manager (1.8.8.28168928-beta)
Pouered by Cent0S release 6.8 (Final)

IP Address: 192.168.1.181  Administration GUI: https://192.168.1.181
Enter ’sudo config_uw' to change platform settings and set a static IP ¢

[ciscolFind [TManager ~1$ _





ijgm_120216_install-findit-manager_step4.png
ent0S release 6.8 (Final)
ernel 2.6.32-642.3.1.e16.x86_64 on an xB6_64

indITManager login: cisco
assword :

fou are required to change your password immediately (root enforced)
hanging password for cisco.

(current) UNIX password:

jew password:

etype new password: _





ijgm_120216_install-findit-manager_step5.png
[cisco@FindITManager cisco]$ sudo config vm






